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Installation and Configuration

Installing the Win4145 Software

The installation program for the Metrics Win4145 software installs all components
necessary to run Metrics Win4145. You can download the auto-extracting archive
MTW4145-44 . EXE from the Metrics Technology website under Downloads link. Be sure to
save the install file to your local hard disk before running the installation. Running the
installation from the website will cause an installation error. You will need a valid customer
login to enter the Software Downloads area.

NOTE: You should also download the latest available hot fix release which can be found in
the same software list and designated MTW4145-44-HFXX.EXE where the XX is the
version of the hot fix. HotFixes contain resolutions to any reported issues and some
enhancements that have been added since the initial release of Metrics Win4145 4.4. It is
only necessary to apply the latest HotFixes to your system since all updates are contained in
the latest build. Save the HotFixes file to your local computer and you can install it after the
base Metrics Win4145 installation is complete.

Obtain a Codeword

This codeword is obtained by registering your software with Metrics Technology. Please
visit our website at www.metricstech.com to register your software and obtain the
codeword. The codeword or temporary codeword will be issued within 24 hours.
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Important Note for Customers Upgrading

The Metrics Win4145 setup program requires that you backup and uninstall the previous
version. To do this, please perform the following steps:

DO NOT LEAVE YOUR BACKUP ARCHIVE IN THE METRICS DIRECTORY! COPY
THE BACKUP.ZIP FILE TO A DIFFERENT LOCATION LIKE A USB DRIVE.

1. Go to the File Menu and select Backup
2. Enter the name of the backup ZIP archive in the W4145 directory (i.e.

C:\METRICS\W4145\backup.zip)
3. Allow the backup utility to complete then copy the .ZIP file to another drive

location.

Procedure to Upgrade Win4145 from 4.0,4.1,4.2,4.3t0 4.4

1. Download the Metrics Win4145 installer MTW4145-44 exe to the local drive of
your computer.

2. Select the MTW4145-44.exe application icon to start the installation program.

A Metrics Win4145 Setup X

Advanced Installer

Welcome to Metrics Win4145 Setup

Welcome to the Wizard for Metrics Win4145 Setup.
. Collecting information

' Preparing installation

' Installing :‘:i ‘;S,:nixse\‘nhzard will install Metrics Win4145 on your computer. Please dick Next

. Finalizing installation

3. Click Next button on the "Welcome" panel.

Metrics Win4145 Installation and Getting Started Guide 5



| & Metrics Win4145 Setup = |

End-User License Agreement Advanced Installer

. Collecting information Please read the following license agreement carefully.

Metrics Technology Scoftware Product
. Preparing installation
End User License Agreement and Limited

. Installing Warranty

@ Finalizing installation .
IMPCRTENT: Please carefully read the License

Lgreement below before clicking "I accept the
terms in the License Agreement" The right to
use this Metrics Technology software Product

4. Read the "Software License Agreement™ and click the I agree to the terms in the
License Agreement button to agree to the terms. Then click Next.

A Metrics Win4145 Setup =G

Installation Folder Advanced Installer

This is the folder where Metrics Win4145 will be installed.

. Collecting information
' Preparing installation

Installin
O "9 To install in this folder, dick Next". To install to a different folder, enter it below or dick

“Browse”,
O Finalizing installation

Folder:

5. Choose "destination location" for installation and click the Next button.
NOTE: It is recommended to select the default C:\Metrics\ as the location to
maintain compatibility with previous versions of the software backups.
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A Metrics Win4145 Setup

Ready to Install Advanced Installer

The Setup Wizard is ready to begin the Metrics Win4145 installation.
O Collecting information

@ rreparing installation Click “Instal” to begin the installation. If you want to review or change any of your

installation settings, dick "Back™. Click "Cancel” to exit the wizard.
0 Installing

0 Finalizing installation

6. Click the Install button to begin the Metrics Win4145 installation.

Installing Metrics Win4145 Advanced Installer

o Collecting information
o Preparing installation
. Installing

o Finalizing installation

7. Allow the Metrics Win4145 installation to complete.
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Metrics Win4145 Setup Complete Advanced Installer

Click the "Finish" button to exit the Setup Wizard.
o Collecting information

o Preparing installation

o Installing

@ Finalizing installation

8. Then click Finish to complete the installation.

9. After the installation is finished, re-start the computer.

\‘y ‘You must restart your system for the configuration changes made to Metrics ICV to take effect. Click ™fes™ to restart now or "Mo” if you plan to

manually restart later.
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Procedure to Install Win4145 (new installation)

1. Download the Metrics Win4145 installer MTW4145-44.exe to the local drive of
your computer.

2. Select the MTW4145-44 exe application icon to start the installation program.

The installation will check for any prerequisites and start the Prerequisites Wizard to
install the necessary software. Please note installation of some of these software
components requires acceptance of the 3 Party license agreements displayed during
installation. Installation of some components can take some time so you should
allow more time for installation if these components are not already installed on
your workstation PC.

Welcome to the Prerequisites
Wizard

The setup has determined that some of the
prerequisites needed to run this program are
missing. This wizard will assist you in getting and
installing those prerequisites. Click Next to
continue to the list of prerequisites.

Click Finish at any time to completely skip the
installation of prerequisites and jump to the
installation of the main program. Click Cancel to
cancel the installation and exit the Setup Wizard.

3. Click Next button on the "Welcome" panel.
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Prerequisites

These programs are needed for the application to run. Click on the check box
next to a prerequisite to selectit for install or to skip it.

Mame Version Action

NET Framework 4.0 Required: 4.0 or higher, Found: ... Instal
Visual C++ 2010 Redistributable x86 Required: any. Found: nothing. Install

Press the Mext button to install the prerequisites.

4. Click Next button on the "Prerequisites™ panel.

B% Microsoft .NET Framework 4 Setup

MET Framework 4 Setup N
Please accepk the license terms bo continue, Micrasate
NET
s
MICROSOFT SOFTWARE v
[w]i have read and accept the license terms.: 3| d
Download size estimate: 0 ME
Download time estimates: Dial-Up: 0 minutes

Broadband: 0 minutes

[Jies, send information about my setup experiences ta Microsoft Corporation,

For more information, read the Data Collection Palicy,

I Install ][ Cancel l

5. Click I have read and accept the license terms then click the Install button on the
"Microsoft .NET Framework™ panel.
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E% Microsoft .NET Framework 4 Setup E]li|@

Installation Is Complete

N MET Framework 4 has been installed,

Microsoft®

Check for more recent versions on i

6. Click Finish to continue.

E® Microsoft Visual C++ 2010 x86 Redistributable Setup

Welcome to Microsoft ¥isual C++ 2010 =86 Redistributable Setup
Please, accept the license kerms to continue. w

MICR.OSOFT SOFTWARE LICENSE TERMS

MICROSOFT VISUAL C+ + 2010 RUNTIME LIBRARIES WITH
SERYICE PACK 1

These license terms are an agreement betwesan Microsoft
Corporation {or based on where you live, one of its affiliates) and
vou, Please read them. They apply 1o the software named abave, o,

[v]i have read and accept the license terms.! ﬂ E

[Jires, send infarmation about my setup experiences to Microsaft Corporation.

For more information, read the Data Collection Policy,

[ Install ][ Cancel ]

7. Click I have read and accept the license terms then click the Install button on the
" Microsoft Visual C++ 2010 Redistributable * panel.
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B Microsoft Visual C++ 2010 x86 Redistributable Setup

Installation Is Complete

w Microsoft Yisual C++ 2010 x86 Redistributable has been

Microsoft* S .
Visual Studio ™=

cent versions of this package on
ebsite,

8. Click Finish to continue.

| A Metrics Win4145 Setup

Welcome to Metrics Win4145 Setup Advanced Installer

Welcome to the Wizard for Metrics Win4145 Setup.

Collecting information

Preparing installation

The Setup Wizard will install Metrics Win4145 on your computer. Please dick Next™

Installing to continue

Finalizing installation

9. Click Next button on the "Welcome" panel.

Metrics Win4145 Installation and Getting Started Guide 12



| & Metrics Win4145 Setup

End-User License Agreement

. Collecting information
. Preparing installation
. Installing

@ Finalizing installation

x

Advanced Installer

Please read the following license agreement carefully.
Metrics Technology Software Product

End User License Agreemsnt and Limited
Warranty

IMPORTENT: Please carefully read the License
Lgreement below before clicking "I accept the
terms in the License Agreement" The right to
use this Metrics Technology software Product

10. Read the "Software License Agreement"” and click the | agree to the terms in the
License Agreement button to agree to the terms. Then click Next.

A Metrics Win4145 Setup

Installation Folder

. Collecting information
O Preparing installation
o Installing

@ Finalizing installation

- X

Advanced Installer

This is the folder where Metrics Win4145 will be installed.

To install in this folder, dick Mext". To install to a different folder, enter it below or dick
"Browse”,

Folder:

11. Choose "destination location" for installation and click the Next button.
Note: It is recommended to select the default C:\Metrics\ as the location to
maintain compatibility with previous versions of the software backups.
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A Metrics Win4145 Setup

Ready to Install Advanced Installer

The Setup Wizard is ready to begin the Metrics Win4145 installation.

O Collecting information

. Preparing installation Click “Install” to begin the installation. If you want to review or change any of your

installation settings, dick "Back”. Click "Cancel” to exit the wizard.
o Installing

o Finalizing installation

12. Click the Install button to begin the Metrics Win4145 installation.

Installing Metrics Win4145 Advanced Installer

o Collecting information
O Preparing installation
. Installing

0 Finalizing installation

Cancel

13. Allow the Metrics Win4145 installation to complete.
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Metrics Win4145 Setup Complete Advanced Installer

Click the "Finish" button to exit the Setup Wizard.
o Collecting information

o Preparing installation

o Installing

@ Finalizing installation

14. Then click Finish to complete the installation.

15. After the installation is finished, re-start the computer.

\‘y ‘You must restart your system for the configuration changes made to Metrics ICV to take effect. Click ™fes™ to restart now or "Mo” if you plan to

manually restart later.
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Metrics Codewords

Metrics Technology software products use a combination Node Locked license model which
includes the generation of a hardware fingerprint for the workstation PC and a Codeword.
The unique combination of a Codeword and license.v2c file allows the software product to
be run on a single workstation PC for which the license has been activated.

Software Codeword Information

There will be a codeword for each software component ordered. This information is made
up of two (2) parts, the Registration Information and Codeword Information. We
encourage all customers to register their software with Metrics Technology. Only
registered users will receive technical support for their products.

Customer ID

The Customer ID is a number that has the form TAXXXXXA. Where the X is a
number. Variations include IHXXXXA, MHXXXXXA, and MKXXXXXA. This
number must match the number on the Security Key.

Product Desc

This is the Product Description. This will be the name of the product, such as
Metrics Win4145.

Product ID

The product ID is MTW4145 should be entered in the ID field

Version

This is the version of the software i.e. 4.4.0

Note: The version number and the codeword are matched. Thus, customers who
have not purchased an upgrade will not be able to run it without purchasing the
correct codeword.

Codeword Serial (Example)

AWRZI-XXC6Z-HK3EM-1RHUO0-GUJ8A-UPXOR

Metrics Win4145 Installation and Getting Started Guide 16



Activate the Win4145 License

1. Go to Help->Codeword... and then click the "Activate License™ button.

Software License Codeword ot

Enter a Codewaord for license # KEYIDEMO

Cancel Activate License

2. A file named license.c2v (Customer to Vendor) will be created in the C:\Metrics
directory.

Activate License pod

File ChMetrics\license.c2v created successfully

Please email this file to info@metricstech.com
to receive a quote and purchase your license.

3. Email this file to "info@metricstech.com" as an attachment

4. Customer Service will create another file named
“<YourLicenseNumber>_license.v2¢”. This is the (Vendor to Customer) file and
will be emailed back to you. ( For example: 1A54999A license.v2c)

5. Copy this file to the C:\Metrics directory and rename it to the abbreviated name
license.v2c

6. Close ICS and restart

Metrics Win4145 Installation and Getting Started Guide 17
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Enter the Codeword

To Enter the Win4145 Codeword Serial number:

1. Open the Win4145 program. In Win4145 select the menu item Help » Codeword to
open the Software License Codeword window.

Software License Codeword X

Enter a Codeword for license # |A54999A

AWRO0I-RHW6Z-UG3EY-3IR7G-REC5A-PR1UR|

|O——K Cancel

2. Enter the Win4145 Codeword Serial number supplied on the product registration
certificate or via e-mail.

Note: It is recommended that you cut and paste the codeword from the registration e-
mail sent from Metrics Technology Customer Service. If typing the codeword from the
keyboard be careful not to transpose letters or numbers. The letter | can be confused for
the number 1 and the letter O can be mistaken for the number 0. Be careful not to
include any space before or after the code word string.

3. Click the OK button.

Metrics Win4145 Installation and Getting Started Guide 18
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Introductory Information

Goal of This Manual

The goal of this manual is to provide a process for the user to be able to create a test
and analyze the data with Metrics Win4145. A test setup will be created that
measures the Threshold Voltage of a MOSFET device. The measured data will then
be plotted and the Vth value will be extracted.

Metrics Win4145 Installation and Getting Started Guide
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Chapter 1- Win4145 Getting Started
Guide

Introduction

The first Chapter of the Self-Paced Guide introduces the Metrics Win4145 software.
This Chapter also provides important information on software versions and support.

Please note that each Chapter builds upon the information presented in the previous
Chapters. It is recommended that the Guide is followed in the order presented.

Topics Covered

What is Metrics Win4145 Software?
Overview of Metrics Win4145 Software
Updating Versions

Support

Metrics Win4145 Installation and Getting Started Guide
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What is Metrics Win4145 Software?

The Metrics Win4145 Software is an application designed for semiconductor
characterization applications. Measurements for different technologies can be created
in a matter of minutes without programming. It is based on the industry standard
Metrics ICS software and provides drivers for the HP4145A/B.

Metrics Win4156 Controls:

e Semiconductor Parameter Analyzers
o HP 4145A
o HP4145B

Overview of Metrics Win4145 Software

Metrics Win4145 Software allows provides an environment for the collection of
data in three steps: Setup, Execute, and Analyze. The Setup of a Measurement
typically takes no more than 1-2 minutes.

Win4145 supports several measurement modes to accommodate most testing
methods.

The Analysis tools in Win4145 include plotting and data extraction. Once the
functions are created, they can be saved with the data.

The advantage of Win4145 is that once a test is created and saved it can be re-
opened and used again, including the analysis.

Metrics Win4145 Installation and Getting Started Guide
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Determining Software Version

The software version and build date are very important when requesting support.

Without this information it is impossible to provide efficient service. Please be
prepared to provide this information when seeking support.

To determine the software version:

1. Open the Metrics Win4145 Software.
2. Click the Help menu item.

3. Click the About item.

| About ICS X

METRILS

ICS Interactive Characterization Software

Version 4.4.0 - HF0O0
License: IA54999A

Copyright 1995-2023, Metrics Technology, Inc.

Metrics Win4145 Installation and Getting Started Guide
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Updating the Metrics Win4145 Software

Please keep your software up to date by downloading and installing the Metrics
Technology HotFixes. Your software will occasionally remind you to check for
updated HotFixes. HotFixes are critical updates for any discovered defects. Often
the issues addressed in the updates are ones that you may just now be
encountering.

Metrics Technology also provides a Service Pack when necessary. A Service Pack
will contain all HotFixes s and new program features. Once a Service Pack has
been created and verified by Metrics Technology, it is placed on our website;
www.metricstech.com. Please note the Service Packs are very large and will take
time to download depending upon your connection speed. Once downloaded the
file is an .EXE application.

Support

Metrics Technology provides technical support to customers for one year after the
purchase of the Metrics Win4145 software. This support period includes a
ninety-day period when telephone support is available. The remainder of the
year’s support is provided by email. Information on how to set-up instruments can
be found under the HELP tab of the software.

Once you have registered at our website, www.metricstech.com as a user you can
access our Knowledge Base through your Customer Portal. If your issue is not
addressed in the Knowledge Base it is most efficient to assist you if you submit a
support ticket through your Customer Portal. Please provide the following
information:

1. Your software License Number (also known as Customer ID (CID) /
Registration number). The sequence will be IA#HHH#H#A, |HE#HHH#ZA or
MK###H##H#A, etc. (# represents a number).

2. Version of software and last HotFix applied. If you are using a currently
supported version be sure you have applied the latest HotFix (HF##)
available at our website accessed through your customer portal. The issue
you may be experiencing may have been addressed in the latest Hotfix. The
latest Hotfix contains all previous Hotfix resolutions.

3. List of equipment you are using to test your devices.

4. The ICS project file being executed.

5. Screen shots of the error code (Alt->Prt Scr) to capture the error window.
Images sent from a camera are often illegible.

Metrics Win4145 Installation and Getting Started Guide
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Chapter 2- Selecting Instruments

Introduction

The Module introduces the Metrics Win4145 (Control Software for HP4145A/B)
measurement engine and demonstrates how to create measurements with it.

Topics Covered:

e Selecting an Instrument
e Configuring the Instrument
e Polling an Instrument

Metrics Win4145 Installation and Getting Started Guide
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Selecting an Instrument Driver

Before creating a measurement, Win4145 must know what instrument is being used.

This is accomplished by configuring Win4145. Once an instrument has been
configured, Win4145 will remember this configuration. The only time Win4145
must be reconfigured is when the instrument is changed or the ICS40.INI file is
erased.

:
2

0
lgﬂ

1. Click the Select Instrument button.
2. Highlight the instrument to be added and click the Connect button.

Available Selected

atd145 Connect -=

demoiv

hpd145

Metrics Win4145 Installation and Getting Started Guide
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Configuring the Instrument

After the Instrument driver is selected, it must be configured.

1. Highlight the instrument to be configured and click the Config button.
2. Enter the GPIB address.

Available Selected

demoiv

Polling an Instrument

To confirm that the instrument and Win4145 are communicating properly, poll the
instrument.

"HP4145 Configuratic =

GPIE D
17 |4145.ﬁ. Semiconductor Parameter Analyzer

[ OK H Cancel ] [ Poll

1. Click the Poll button.
2. Click the OK button to close the Configuration window.
3. Click the OK button to close the Instruments window.

Metrics Win4145 Installation and Getting Started Guide
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Chapter 3- Creating Measurements

Introduction

The Module introduces the Metrics Win4145 (Interactive Characterization Software)
measurement engine and demonstrates how to create measurements with it. Special
demonstration drivers have been created to allow the development to be independent
of the instrument. For details about the instrument drivers provided with Metrics
Win4145, please refer to the Metrics Win4145 documentation. The steps to creating
a test method will be covered.

Topics Covered

e Creating a Sweep Measurement
e Creating a Spot Measurement
e Creating a Time-Based Measurement

Metrics Win4145 Installation and Getting Started Guide
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Create a Sweep Measurement

The following example demonstrates how to create a sweep measurement using
Win4145. This example uses the demonstration driver within Win4145.

To Create a Sweep:

1.  Open the setup editor

The Setup Editor is the place in Win4145 where the measurement is
configured. It can be opened by clicking the Setup Editor button.

Setup Editor |E|
Mew Devices Sources Options
Copy Rename Delete Time

2. Click New to create a new setup

Metrics Win4145 Installation and Getting Started Guide



3. Name the Measurement Setup

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

-

Mew Setup £2 |

Mame: SWEEP

| oK || cancel |

a. Entering a name then click the OK button.
4.  Select Source Units
The source units correspond to the outputs of the instrument you are using.

Metrics Win4145 provides a graphical way to document the connections for
later reference. To add a source unit:

’SetupEdi'tor @
I Mew “ Devices “ Sources H Options ]
I Copy “ Rename “ Delete H Time... ] [SWEEF' v]
[ Source Units |E|‘
DEMOIV.sMU1__ iR
D DEMON.SMU2
DEMOIV.SMU3 )
DEMON.SMU4 3
DEMOIV W51
DEMOIV.VS2
I_ DEMON WM =
G BN 'H H b
b= [ Instruments ]

[ Source Units ]

: T

a. Click on the Sources button to open the Source Units window.
b. Highlight the specific unit.
c. Click the blue box beside the device lead in the Setup Editor.
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To remove a source unit:

a. Highlight the attached unit.
b. Click the blue box beside the device lead in the Setup Editor.
c. Click the Yes button when asked if "Do you really want to remove the

source".

rSetup Editor [==]
I MNew " Devices ]I Sources ][ Options l

I Copy ]I Rename ]I Delete " Time__. l ’SVVEEP -

sMuz

|
] u:ll_--;r:i?1:___-l| ! ‘f
|

e

SMU3

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pin-out does not have to
exactly match, rather it is only for reference.
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5.  Configure Source Units.

In this example we are creating a sweep source, so we must configure the
source unit properly. To setup a sweep source:

SMU1

8
O
SMU Setup £3
Source: | sMU1
Stimulus Measure Sweep Time
@ Voltage J|Voltage VD Hold 0.0000
Current | Current  ID Delay 0.0000
Force Conditions
Mode |SWEEP - Start  0.0000  Volts
Type |LIM - Stop  5.0000  Volts
Mo, Points g1
Compl 10,1000 Step Size  0.1000  Volts
Time 5tim Time Measurement Bias
@) Voltage Time Bias  0.0000  Volts
Current Compliance  0.1000
| Ok | | Cancel |
1. Select the stimulus type.
2. Select the values to be measured (see note below).
3. Click the blue box beside the device lead in the Setup Editor.
4. Select the sweep timing (see note below).
5. Select the Source Mode. In this case we want it to be Sweep.
6. Setup the sweep parameters.

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore, in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for VVoltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. The Sweep Time parameters are to control
the rate of the sweep. Please note that these inputs vary for different
instruments.
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Create a Spot Measurement

In this example we will create a spot (or single point) measurement. Most of the
steps are the same or similar to creating a sweep measurement. The first step is to
open the setup editor. The setup editor can be opened by clicking the Setup Editor
button.

To Create a Spot Measurement:

1. Open the setup editor

The Setup Editor is the place in Win4145 where the measurement is
configured. It can be opened by clicking the Setup Editor button.

Setup Editor [ 22|
Mew Devices Sources Options
Copy Rename Delete Time
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2. Name the Measurement Setup

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

.~ 'y

Mew Setup [ == |

Mame: SPOT

| OK || Cancel |

a. Click the New button and type in a name.
b. Click the OK button after entering the name.
c. Select Source Units.

The source units correspond to the outputs of the instrument you are using.
Metrics Win4145 provides a graphical way to document the connections for
later reference. To add a source unit:

Setup Editor @
l Mew " Devices " Sources " Options l
l Copy " Rename " Delete " Time.___ ] [SF'OT v]
[ Source Units |§|‘
DEMOINV.SMU2 -
D DEMOIV.SMU3
DEMOINV.SMU4
DEMOIV. VS =
DEMOIV . VS2
DEMOIV VW1
|_ DEMOIV V2 -
G B -4 H B
= [ Instruments ]

[ Source Units ]

: o]

Done

a. Click on the Source Units button to open the Source Units window.
b. Highlight the specific unit.
c. Click the blue box beside the device lead in the Setup Editor.
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Setup Editor @

‘ Mew H Devices H Sources " Options ‘
‘ Copy H Rename H Delete " Time. .. ‘ |SF'OT v|
SMU1

smuz [E

Done

To remove a source unit:

a. Highlight the specific unit.
b. Click the blue box beside the device lead in the Setup Editor.

c. Click the Yes button.

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pin-out does not have to
exactly match, rather it is only for reference.
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3. Configure Source Units.

In this example we are creating a spot source, so we must configure the
source unit properly. To setup a spot source:

SMU Setup ==
Source: | sML1
Stimulus Measure Sweep Time
o ll."l:lltEIQE o "."l:lltﬂgE VD Hold | 0.0000
Current | Current ID Delay | 0.0000

Force Conditions

Mode |COMST - Value [.0000  Volts

Compl  0.1000

Time Stim Time Measurement Bias
@) Voltage Time Bias  0.0000  Volts
Current Compliance  0.1000
| Ok | | Cancel |

Select the stimulus type.

Select the values to be measured (see note below).

Select the Source Mode. In this case we want it to be Const.
Setup the source bias.

Eall el

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore, in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for VVoltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. Please note that these inputs vary for
different instruments.
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Creating a Time-Based Measurement

In this example we will create a time-based measurement. Most of the steps are the

same or similar to creating a spot measurement. The first step is to open the setup
editor.

To Create a Time-Based Measurement:

1. Open the setup editor.

The Setup Editor is the place in Win4145 where the measurement is
configured. It can be opened by clicking the Setup Editor button.

Setup Editor ==
e Devices Sources Options
Copy Rename Delete Time
1Y
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2. Name the Measurement Setup.

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

-

’NewSetup @

MName: TIME]

[ Ok ” Cancel|

a. Click the New button and type in a name.
b. Click the OK button after entering the name.
c. Select Source Units.

Setup Editor @

| New | Devices | Sources | Options |

| Copy | Rename | Delete | Tme.. |  [TmE |

-

Source Units (22|

DEMOINV_SMUA -

D DEMOIV.SMUZ2
DEMOIV.SMU3
DEMOINV SMU4
DEMOIV VS
DEMOIV.VE2
DEMOINV VI

m

4

G ]

TLT

IB[

Instruments ]

[ Source Units ]

o]

Done

The source units correspond to the outputs of the instrument you are using.
Metrics Win4145 provides a graphical way to document the connects for
later reference. To add a source unit:

vy

Metrics Win4145 Installation and Getting Started Guide



Setup Editor (24

| New | Devices || Sources | Options |

I Copy “ Rename “ Delete " Time... I | TIME =

Done

a. Click on the Source Units button to open the Source Units window.
b. Highlight the specific unit.
c. Click the blue box beside the device lead in the Setup Editor.

SMU3

To remove a source unit:

a. Highlight the specific unit.
b. Click the blue box beside the device lead in the Setup Editor.
c. Click the Yes button.

Note: The graphic is merely a representation of the device. The software

does not expect behaviors from the data. Thus, the pin-out does not have to
exactly match, rather it is only for reference.
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3. Configure Source Units.

In this example we are creating a time stimulus source, so we must configure
the source unit properly. To setup a time stimulus source:

SMLU

SMU Setup ==
Source: | sMU1
Stimulus Measure Sweep Time
o "."I:IHZEIQE J "."D'tEIQE VD Hald | 0.0000
Current | Current  ID Delay | 0.0000

Force Conditions

Mode | COMNST - Value  0.0000  Volts

Compl 10,1000

Time Stim Time Measurement Bias
@ Vaoltage Time Bias =~ 4.0000  Volts
Current Compliance  0.1000
| oK | | Cancel |

a. Select the stimulus type.
b. Select the values to be measured (see note below).
c. Select the Time Bias and Compliance.

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for Voltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. Please note that these inputs vary for
different instruments.
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4. Set Time Parameters.

We must specify the time interval that the measurements will be made. To

setup the time parameters:

Time._.

Setup Editor

| New || Devices || Sources | Options |

| Copy || Rename | Delete | Time.. |

TIME

SMuUA

=

SMU3

Done

5]

Time Parameters
Units

@ Sec
~ Min
' Hrs

Type |LIM -

Wait  0.0000
Start  0.0000
Stop 10.0000
Points 11

Step 1.0000

[Tl Comply to Stop

Done

Select the Time Units.
Select the sampling type.
Enter the Wait time.

o0 ow

Stop, option if desired.
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5. Set Measurement Mode.

We must specify the measurement mode as Time Meas. To setup the
measurement mode:

T4

-

Measure

| TIME -

P | Single
G2 | Repeat
b M| Append

| History
S | Auto

TIME MEAS  ~|

: ZERT
j: ISER: TR

STEY ZERD
CFF CAMCEL

B | Stop

a. Select the Setup.
b. Select the TIME MEAS mode.
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Chapter 4- Executing Measurements

Introduction

This Module details the execution of the measurement using Win4145.

Note: When creating new tests, it is necessary that the data be measured before the
analysis is created.

Topics Covered

e Measurement Remote Control
e The Date Window
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Measurement Remote Control

Metrics Win4145 contains a tool named the Measurement Remote Control. This
control is activated by clicking the Measure button on the Win4145 toolbar.

@

This toolbar contains buttons to begin the measurement as well as menus to select
the measurement and mode.

Note: The remote control window can be moved anywhere on the desktop.

Single

4
G2 | Repeat

B | Append
| History
S | Auto

The Measurement Remote Control has four sections.

Metrics Win4145 Installation and Getting Started Guide

44



Section 1: Measurement Menu

This pull-down menu allows the selection of a specific test to be executed.

Section 2: Execute Buttons

This section contains the buttons that will start the measurement. Several
modes of measurement are available and the buttons correspond to the
selected mode.

Section 3: Measurement Mode Menu

This pull-down menu allows the selection of the measurement mode. Most
measurements are made in standard mode, however Win4145 does support
several specialized measurement modes which require this measurement
mode setting to be modified. (i.e. ICS time measure modes) Please refer to
the Wind4145 Reference Guide for details on the additional modes.

Section 4: Stop Button

This button allows the user to stop the measurement.
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The Data Window

When a new setup is created the spreadsheet is automatically created when a test
setup is created. It will begin as a minimized window in the lower left corner of the
Win4145 window. To view the data simply double-click the window that has the
same name as the test setup.

s =

LI VTH =5 ESR[
[ Clear ][ Max H Min H Direct ] 080742012 1
ID [VG [T + [GM = |GMMAX + | TFIT + -
1 0.0750p 0.0000 158972 05307  20.0000 -D.5828m
2| 0.1580p 0.1000 18787 -0.5519m
3| 04507 0.2000 5.9548p 0.5151m
4 1.3550p 0.3000 0.0152n 0.4782m
5|  428%p 0.4000 0.0642n -0.4414m
6 0.0142n 0.5000 0.2216n -0.4045m
7| 0.0486n 0.6000 0.7938n -0.3676m
3|  0.1740n 0.7000 3.0511n -0.3308m
9| 06588 0.2000 0.0117u -0.2935m
10 25201n 0.9000 0.04580 0.2570m
11 9.81%3 1.0000 0.1850u 0.2202m
. 1% N NIGA., 1 1M 7300, J‘.1!1':1:—.H

The Data window automatically returns the measured data and displays it. When
parameters are extracted the values are also displayed.

Note: Win4145 has a feature named "Enable Data View". To enable or disable this
feature select Workspace from the Options menu.

Workspace @
Default Plot Colors
Curve: Axis:
Numbers: Labels:
Cursors: Active Cursor:
Options:
Font [Arial v] [¥] sShow Messages
Export Delimeter [¥] Eng Notation
Significant Digits EEIzizEED
|¥] Autoscale
Default Device [#] Update During
Sync dataview
| ok || pefeuts || Fie Mar Setup... |
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Edit the Data View

L@EE‘I_
S
[ Define Data View |
Setup Name:[‘n.,fTH v]
Data Orientation:

@ Column Vectors
[ Append data only to

Row Vectors View Vectors.

Data Vectors: Wiew Vectors:
R - | [ Ada> | [Colt: D

D ———— | Col 2: VG

VG Insert -= Col 3: VT

GM = ————— |Col4: GM
GMMAX —— | |Col&: GMMAX
TFIT Remove | |ogi6-  TAIT
VT o =

TIME | |Remaove All

This feature allows the user to select only data vectors that are chosen to be
displayed. It also allows the reordering of the data vectors as they appear in the data
window. The default behavior is for the Data View to be disabled which displays all
vectors for a chosen setup.
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Sync the DataView with Microsoft Excel

This feature allows the user to automatically synchronize all DataViews with a
Microsoft Excel workbook. The default behavior is for the DataView to be disabled
which displays all vectors for each setup in separate tabs of the workbook.

Note: Win4145 has a feature named "Enable DataView". To enable or disable this
feature select Workspace from the Options menu.

Note: Win4145 has a feature named "Sync dataview". To enable or disable this
feature select Workspace from the Options menu.

Sync the Data View with Microsoft Excel

This feature allows the user to automatically synchronize all Data Views with a
Microsoft Excel workbook. The default behavior is for the Data View to be disabled
which displays all vectors for each setup in separate tabs of the workbook.

Note: Win4156 has a feature named "Enable Data View". To enable or disable this
feature select Workspace from the Options menu.

Note: Win4156 has a feature named "Sync Data View". To enable or disable this
feature select Workspace from the Options menu.

r‘|.I"|’|:tr|~:5pau::ne @
Default Plot Colors
Curve: m Axis: Gray—v
Mumbers: ||.l'|,|'|-||te—v Labels: |_1;Gramj.-—v
Title: ||.l'|,|'|-||te—v Window: Ena.j.f_—v
Cursors: '|.fu'h|te—v Active Cursor: m
Options:
Font |Aria| v| | Show Messages
Export Delimeter TaB | (¥I|EngMotation
Significant Digits c Enable Data View
|V Autoscale
Default Device MOSFET ~| [V|Update During
Sync dataview MSE:«:EI—v
| ok || Defaults | | File Mar setup...
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LI VTH feE) ==
[ Clear ] [ Max ] [ Min l [ Direct ] 08j07}2012 1*
ID [VG [GM + [GMMAX + [TFIT+  [VTH+ | =

1 01087 00000 13488  20.0000 -0.8533m 15972

2| 02435 0.1000 2722% -0.79%9m

3| 08532 0.2000 B35301p -0.7465m

4| 1.969p 0.3000|  0.0278n £0.6931m

5|  6.210% 0.4000)  0.0930n -0.6396m

6|  0.0206n 0.5000 032120 -0.5862m

7| 0.0704n 06000  1.1577n -0.5328m

8| 02521n 0.7000  4.4218n 0.47%4m

9| 095480 0.8000)  0.0170u -0.4259m

10|  36524n 0.5000  0.0664u 0.3725m

1]  0.0142u 1.0000  0.2680u 0.3191m

12| 0057w 11000 1.0578 0.2657m -
<] | _>|J

While the "Sync Dataview" is selected all data will be automatically synced to the
MS Excel spreadsheet.
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H - 5 Boolkl - Microsoft Excel - = b4
- Home |Insert | Page Laynu| Farmulas | Data | Review |‘u"iew | Team |® - 8 X
].3 E L (8] i Q} Text Box [~
_ : Ly~ _ 2] Header & Footer *gd
Pnrot;l'able Table Picture F_I Chfrts Hyperlink ﬂWordArt* Q
Tables INustrations Links Text
I Al - (- fe | 1D ¥
A B C D E F G L
1|ID ViE G + GMMAX + TFIT + WTH +
2 | 1.09E-13 0 1.35E-12 20 -0.00085 1.597227
3 | 2.44E-13 0.1 2.72E-12 -0.0008 3
4 | B.53E-13 0.2 B.63E-12 -0.00075
5 | 1.97E-12 0.3 2.78E-11 -0.00069
6 | 6.21E-12 0.4 93E-11 -0.00064
7 | 2.06E-11 0.5 3.21E-10 -0.00059
B | 7.04E-11 0.6 1.16E-09 -0.00053
9 | 2.52E-10 0.7 A4.42E-09 -0.00048
10| 9.55E-10 0.8 L7E-08 -0.00043
11 | 3.65E-09 0.9 6.64E-08 -0.00037
12 | 1.42E-08 1 2.68E-07 -0.00032
13 | 5.73E-08 1.1 1.06E-06 -0.00027
2.26E-07 1.2 4.01E-06 -0.00021
m VTH - Sheetl  Sheet? .~ Sheet3 ,dI- m [
Ready | | -

[

You can create user defined macros to perform further analysis to create custom
reports and save out to the file system in .XLS format.

Notice that not only the measured data vectors are synced but also any transforms
that have been setup for the raw data.
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Chapter 5- Plotting Data

Introduction

This Module introduces the plotting tool of the Win4145 software. The plotting tool
allows for the graphical analysis of data measured with Win4145.

Topics Covered

e Creating a Plot
e Editing a Plot
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Creating a Plot

The Metrics Win4145 software uses a custom plot tool to display plots and provide
analysis features like read-out cursors and line fits.

To create a new plot:

v

Setup Plot View =

Plot Definition:

Axis Options: | X-Axis... | | | Y1-Auis...| | |Y2-Auxs...|

Data Group: IUG v] ’||:} v] ’GM v]

ScaleType: (LN «||[un  ~||[un ]

Min Value: 0 -0.0002 -0.0001
Max Value: 4 0.0006 0.0004
| Done | | Cancel | | Apply | | Build Group

1. Click the Plot button on the toolbar.
2. Configure the plot.
3. Click the Done button and the plot will be created.
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L/ VTH-1 =R =R
Title
% 0.2000m 0.4000m Conditicns:
= E ] Con: SMUH
- 0.5000m £ Val: 0.0500 v
- 0.2000m
0.4000m £ Swp: SMUZ
= Start: 0.0000 V
i 0.2000m & 10.2000m Stop: 4.0000 V
o - e
o o Step: 0.1000 V|
0.2000m |-
é Q o2 = . O |pis 41
o.1000m b 9.1000m
o b Con: SMU3
001080 Bac e oseccmsos 1 Val: 0.0000 V
- | NP o 0.0000
-0.1000m :_ b Con: SMU4
2 C Val: 0.0000 ¥
ks g2000mb o o o o 0 o 1, 1, T1-01000m
- 0.000 1.000 2,000 2,000 4000
i
& VG
ICS 13:50:53
08/0T/2012

Note: The plot is made from whatever data window is currently active. The
name of the plot in the Window title is the setup name followed by a dash
and a number. Multiple plots can be created from the same data set, the
number will just increase.
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Editing a Plot

L via =)

ALtozcale Title

HHE

X | Y
T fod
[ [l
E [od
< [od
[ [od

Pl

CUrS0TS

e | b | = I I I .
- Fit #1 : 1.000 2.000 2.000 4.000
& Fit #2. VG
E Zoom Qut| Owerlay | Memaory
5 | e

The plot window contains the editing tools for the plot.

1. The Axis button reveals the tools to change the axis from linear to
logarithmic and to auto scale the plot.

2. The Cursors button allows the addition and control of cursors on the plot.

3. The Fits button allows the application of curve fits related to the cursors.

4. The Opts button presents several options for adding notes to the plot,
overlaying plots, zooming features, and setup changes.

These functions are discussed in great detail within the Win4145 Reference Manual.
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Chapter 6- Extracting Data

Introduction

After executing a measurement, Win4145 can extract parameters. Once the
procedures are defined, each time the measurement is run the calculations are
performed automatically.

This Module demonstrates how to extract parameters from the raw data using the
Transform Editor within Win4145.

Topics Covered

e The Transform Editor
e Defining a Transform
e Sharing Data Between Transforms
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The Transform Editor

Calculations are created within the Transform Editor. To open the editor, click the

"Transform Editor" button on the Win4145 toolbar.

| f(x)

Transform Editor

Setup Mame: "l,ﬂ'H

Transform:

=i

Edit Constants_..

GM=DELTA{IDYDELTANG)
GMMAX=MAXPOS(GM)
TRIT=TANFIT(VG,ID, GMMAX)
WT=XINT(TFIT)

(Jl . J[ ) | |sBeckspace| [+ J[ - || * ][
Functions: Vectors: Constants:
ABS D « | |PI [rad] -
ARCCOS VG K K] '
ARCSIN GM(+) ‘E Q [C] 3
ARCTAN GMMAX(+) [ MO [ka]
AT TFIT{+) EV [J]
AVG = |VT{+) = |UQ [Him] -
| Daone || Save || Clear || Delete |De|etehl||| Insert |

The Transform Editor contains several areas:

1. Transform Entry Box

The location to enter the transform.

2. Defined Transform List

A list of all transforms defined for this setup.
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3. Function List

Predefined functions available for the calculation of parameters.

4. \ector List

A list of the measured and calculated data vectors.

5. Constant List

A list of constants that can be used in calculations.

6. Edit Constant Button

Allows constants to be defined and edited.

7. Action Buttons

Controls for the saving of transforms, deleting of transforms, and exiting the
Transform Editor.

Metrics Win4145 Installation and Getting Started Guide

58



Defining a Transform

Calculations are created within the Transform Editor. To open the "Transform
Editor" click the f(x) button on the Win4145 toolbar.

Transform Editor @

Setup Name: "'u"TH *l |Edit Donstants...|

Transform:
GMMAX=MAXPOS(GM)|

GM=DELTA(IDVDELTANVG
GMMAX=MAXPOS[(GM

TFIT=TANFITVG, 1D, GMMAX)
WT=XINT{TFIT)

() (1] |<-Backspace | | + | - [[ * J[ /
Functions: Vectors: Constants:
ABS | (1D « | |PI [rad] ~
ARCCOS [ VG K K] L
ARCSIN GM(+) ‘E‘ Q [C] i
ARCTAN GMMAX[+) | [MO [ka]
AT TEITi+) EV [J]
ANVG | (VT{#) = |UD [Him] -
| Done | | Save | | Clear | | Delete |De|ete All | | Insert |

To create a calculation:

1. Enter the calculation in the "Transform" box. The calculation must be
in the form variable = function(vector)

2. Hit the Enter key or click the Save button to save the new
calculation.

3. Once all calculations have been saved, click the Done button.
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Sharing Data Between Transforms

Data vectors from one setup can be shared with another setup in the same project file. For
instance, if one setup TEST2 measures the resistance from 0 — 1.0 Volts and the second
TEST1 from 1.1 — 2.0 Volts the data can be merged to form a full sweep from 0 — 2.0 V.
You can simply create a transform setup TEST2 of the form Variable = Setup | Vector
to allow sharing the data from setup TESTL.

To Share Data:

We must first create two different setups with TEST2 being the sweep from
0-1V and TEST1 being the sweep from 1.1to 2 V.

[ Transform Editor @ﬁ
Setup Name: | SESE hd Edit Cunstants_._|
Transform:

VAHI=ETEST1VA
[AHI=TEST|1A

(JL. Lo | |sBackspace| [+ [ - J[ = ]| ¢
Functions: Vectors: Constants:
ABS - WA Pl [rad] -
ARCCOS Fiy K [JK] [
ARCSIN WAHI+) Q [C] 3
ARCTAMN LAHI+) MO [kq]
AT TIME EV [J]
AVG - | |ACCSTRESS LD [Him] 7
| Done || Save || Clear || Delete |De|etehl||| Insert |

1. Open the Transform Editor and make sure the setup name is

TEST2.

2. Create a new Transform VAHI as shown above specifying the vector
setup name TEST1 and the vector name VA separated by the pipe

character " | .

.

The resulting transform will contain the VA data from TEST1.
4. Click the Save button to save VAHI.
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You can use the same step to create the transform IAHI to share the 1A

data from TEST1.
B TesT1 (== ] =
Clear l [ Max l [ Min l [ Direct l 080720
VA 1A | | | | j
1 0.0000 0.104%
2 0.1000  4.4441p
3 02000  0.4726n
4 0.3000, 0.0778u
5 04000  8.893%
5 05000  0.1426m
7 0.6000  0.3110m
[ 0.7000  0.4291m
9 0.8000  0.5255m
10 0.9000  0.5095m
11 1.0000  0.6861m
12
13 v
14
] | f

After applying the transforms VAHI and 1AHI the data from TEST1 is
appended to the data from TEST2 and displayed in the data window for

TEST2.
) TesT2 = |[=] =
[ Clear ] [ Max ] [ Min ] [ Direct ] 08071201
VA 14 [VAHI+  [IAHI= | | -
1 110000  0.1051p 0.0000) 0.104%
2 11900  4.4496p 0.1000| 4.4441p
3 12800 0.4732n 02000 047260
4 137000 0.077%u 03000 0.0778u
5 14600  8.5044u 04000  8.8%3%
3 15500  0.1428m 05000  0.1426m
7 16400  0.3114m 06000 0.3110m
8 17300  04297m 0.7000 0.4291m
3 18200 05261m 0.8000  0.5255m
10 15100 05103m 0.5000  0.6095m
11 20000  0.6865m 10000  0.6861m
12
13 .
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Chapter 7- Saving Data

Introduction

Metrics Win4145 saves the data within the standard Windows File System. This
Module covers the data. Where it is stored, how it is stored, and how to retrieve it are

covered.

Topics Covered

e Where is the Data?
e Saving a Project
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Where is the Data?

Metrics Win4145 allows the data to be stored anywhere within the windows file
system.

Note: If you want the Win4145 Backup utility to save the data, make sure it is saved
within the Metrics\ICS\projects directory.

Saving a Project

The project is a collection of the test method(s) and the data. To save the data
simply select File >> Save As and select the directory and filename or to save the
currently open project simply select the Save toolbar icon.

o J
\
File Save As (3w
QCJ | .+ Computer » BOOTCAMP (C:) » dev » metrics » bin » ics » projects - | 45 | | Search projects o) |
Organize « MNew folder =~ M '@'
" B o Name : Date modified Type Size
B Desktop 4 b1505-diode 9/29/2011 7:29 PM  iCalendar File 13KB
& Downloads 7 B2900test 7/27/201210:31 AM  iCalendar File 15KB
12| Recent Places rﬁ B2900test? 7/28/201211:15 AM  iCalendar File 10 KB
] ics2600-mos 7/11/201210:31 AM  iCalendar File 26 KB
=l Libraries = [ ics#145-mos 8/6/201212:59 PM iCalendar File 18 KB
3 Documents rﬁ ics4156-diode 6/27/2012 4:45 PM iCalendar File 12KE
J'- Music ] icsS270vt 11/21/2011 843 AM  iCalendar File 9 KB
| Pictures ] ics5270ut2 11/21/2011 1:28 PM  iCalendar File 18 KB E
[="] Subversion ] icsatd145 8/6/2012 2:23 PM iCalendar File 11 KB
B videos ] icsb2900-mos 7/24/2012 216 PM iCalendar File 9KE
[ rﬁ icsb2912-mos 77252012 9:56 AM iCalendar File 16 KB
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